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Getting Started
WinBuild generates BASIC programs for the Eason Technology 1000 Series products.
Programs are created by using simple menu selections and direct screen entry of text and
graphics. It also serves as an upload and download tool for the 1000 Series Intelligent Operator
Interface (OI), as well as an interface to standard Windows editor and terminal utilities.
WinBuild is very easy to use! If you have ever programmed before, the process of building code
for Eason Technology OI's is going to be extremely simple. Follow the few steps in getting
started, and start programming. If you are a new programmer, we suggest that you take a few
minutes and try out the built in tutorial in WinBuild. Either way, we are convinced you will be
"hooked" on Pseudocode programming once you try.
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WinBuild Tutorial
As with any software package, the better understanding you have of the capabilities of the
product and how to access these capabilities, the better you will be able to use the product. A
little time spent up front to gain this understanding will allow you to create better programs faster.
WinBuild comes equipped with a Tutorial to help you learn this powerful software development
tool.
If you have never used WinBuild, or particularly if you have never used the
ApplicationBuilder for DOS, we strongly urge you to take the 15 minutes or so necessary to
complete the Tutorial. Just select the ApplicationBuilder Tutorial item from the Help menu and
follow the on screen instructions.

The Basics
Running the ApplicationBuilder is quite simple, and requires no special software skills. You may
choose to install WinBuild in concert with your OI set-up, or install WinBuild now and wait and
set up your OI later. Follow the hook-up diagram below if you want to set up your OI. To hookup your OI, connect one end of the supplied NULL MODEM cable to COM2 on the OI, and the
other end to an available serial port on your PC (either COM1 or COM2). Note which serial port
on the PC that you have connected to (for information on the serial ports for your PC refer to
your PC's instruction manual). Refer to the installation instructions in either the 1100 or 1000
product manuals for specifics on power, mounting, and other installation considerations.]
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Connecting the 1000 Series to your PC
WinBuild is supplied on one high density 3 1/2" diskette. Make back-up copies of your diskettes
before attempting to use them. Save your original WinBuild diskette in a safe place. WinBuild
can be installed on any PC that has Windows 3.1 installed on it.
To install WinBuild, run Windows on your PC. Select the File Menu selection in the Program
Manager by clicking it with your mouse. Select Run in the same manner. A window will appear
and ask you to enter a COMMAND. Type in B:SETUP if your 3 1/2" drive is drive B or
A:SETUP if your 3 1/2" drive is drive A. WinBuild's install program will take care of the rest!
You will be asked to make a few decisions about the directory where WinBuild will be placed. In
most cases, just press enter to accept the default conditions.
When WinBuild's install program is finished, you will have a new program group with the
WinBuild icon in it. To run WinBuild, simply double click this icon. If at any time you need help
running WinBuild try pressing F1, the help key. You will find help for the action that you are
trying to do, as well as access to the on-line manual for WinBuild.
To select the COM port on your PC that is connected to the OI, select Utility, Configuration,
and select either COM1 or COM2. Select OK to close the Configuration window.
The picture below shows the layout of the WinBuild screen. It is composed of five basic
components. At the top there is the MENU BAR. This is where the pull-down menus for
operating the ApplicationBuilder originate. Directly below the MENU BAR is the TOOL BAR.
The TOOL BAR contains pushbuttons which simplify the operation of WinBuild. In the center is
the PSEUDOCODE GENERATION AREA. This is where English language program statements
that we call pseudocodes are placed and edited. In the lower left is the SIMULATION OF THE
OI's SCREEN. This represents the 8 line by 40 character LCD screen on the OI. The lower right
contains collection of ACCELERATION TOOLS tools to accelerate the generation of a program.
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The WinBuild Screen
To demonstrate the power of the ApplicationBuilder, a very simple example program will be read
from disk, viewed, converted to BASIC, sent to the Eason interface, and then run.
Open the file menu by selecting the File and Open functions. You will see a window appear
which contains a listing of the demonstration builder files on the ApplicationBuilder diskette.
Select EASY.BLD and then click OK. The pseudocode for EASY.BLD will appear on the screen.
Here is a listing of the pseudocode for EASY.BLD:
- GOTO SCREEN begin
*>SCREEN begin
- PUT TEXT AT (7,7): "PRESS THE 'MORE' SOFTKEY"
- PUT LARGE TEXT AT (3,3): "TO THE BUILDER"
- PUT HUGE TEXT AT (2,1): "WELCOME"
- SOFTKEY (1) "MORE" GOTO SCREEN morescr
- SOFTKEY WAIT
*>SCREEN morescr
- PUT LARGE TEXT AT (3,1): "EASON TECHNOLOGY"
- PUT LARGE TEXT AT (2,2): "MAKES PROGRAMMING"
- PUT HUGE TEXT AT (3,2): "EASY!!"
- DELAY 2000
- GOTO SCREEN begin
- END OF PSEUDOCODE
Observe the first two lines and the last line of the pseudocode. These three lines are
automatically inserted by WinBuild. You may have noticed them on the screen before you
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retrieved EASY.BLD from disk. These lines cannot be deleted, edited or moved. They are
essential for WinBuild's operation. Notice that each line begins with a dash (-) or a *> sequence.
These tell WinBuild that the line is pseudocode, and what to do with it. A line starting with *> is a
new screen, while a line starting with a dash is pseudocode that will execute for that screen.
Don't worry about generating these special symbols. WinBuild does that automatically for you.
Next, select the "*>SCREEN begin" pseudocode by clicking on it. Notice that the SIMULATION
OF THE OI'S SCREEN contains text. This is the text that will be placed on the OI's actual
screen when BASIC is generated and the program is run on the OI. Now try selecting the fourth
line:
- PUT TEXT AT (7,7): "PRESS THE 'MORE' SOFTKEY"
Notice that the "PRESS THE 'MORE' SOFTKEY" is highlighted on the OI's screen. If you move
the mouse cursor over the highlighted text and then press and hold the left mouse key, you can
move the text around on the screen. When you release the text, it will stay in its new location.
This operation may be done without selecting the fourth line, but by simply clicking and dragging
the text that is visible. You may double click on the selected pseudocode, or press enter on the
selected pseudocode. This brings up a window that will allow the text position, format, and
content to be changed. Press ESC (leave the program unchanged). If you were to press
ENTER, the new position and text would have been saved.
Click the PSEUDOCODE button or press SOFTKEY F5. This is how you select pseudocodes to
place on screen. Type an S. Press ENTER. The SCREEN PSEUDOCODE has been selected.
This allows you to type text directly on the screen. Click on Cancel to leave the program
unchanged.
Click on the COMPILE button. This function generates BASIC. Notice that the number of basic
lines generated are displayed on screen during this process.
The BASIC program generated by EASY.BLD may be viewed by running the EDITOR. This is
performed by selecting Utility and Editor menu selections. EASY.BAS is now loaded into the
EDITOR. The default EDITOR is Windows Notepad (this may be changed under the Utility,
Configuration menu. After examining the BASIC code generated, let's send it to the OI (if it is
attached to the PC at this time).
Click on the Send button (if your OI is attached to the PC). Select EASY.BAS and click on OK
This begins the download process from the PC to the OI. While data is transferred between the
PC and the OI, a window will show the number of lines being transferred. An activity bar shows
the percentage of completion for the download. When the process is complete, the program has
been downloaded. Press F1 (RUN) on the OI. You should see the screens and softkeys that
were present on the SIMULATION OF THE OI'S SCREEN on the PC.
Once you have successfully downloaded and run EASY.BLD, try loading, examining, and
compiling other example programs provided on the WinBuild diskette(s).

Trouble-Shooting Communications
If your attempt at down-loading a program to the OI was unsuccessful, check the serial port
connections between the OI and the PC. Look for the following things:
1. Is power applied to the OI?
2. Is one end of the NULL MODEM cable connected to COM 2 of the OI? If it is not,
reconnect it to COM 2.
3. Which port on the PC is the other end of the serial cable connected to: COM 1 or COM
2? Does this match with the selections made in the Configuration dialog box? If you
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are unsure, recheck the Configuration dialog box and make sure that you have the
correct setting.
4. Are the NULL MODEM cable connectors securely seated into their respective sockets.
Try tightening the hold-down screws on the NULL MODEM cable.
5. Are you using the NULL MODEM cable supplied by EASON TECHNOLOGY? If you are
unable to find the NULL MODEM cable supplied by us, many computer stores can
provide them for a modest cost. Be sure to ask for a NULL MODEM cable with female
to female connectors on it.
6. Do you have other Windows programs that access the serial port? For example modem
programs that are active but not running may lock the serial port away from WinBuild.
Check to see if you have any programs running like a background FAX or modem
program. If one is found, disable it.

Operating WinBuild
If you feel comfortable with the discussion so far, go ahead and try WinBuild on your own. If you
get stuck at any point, you can press F1 or click on the Help menu item. WinBuild help is
context sensitive, and also contains a very helpful topic cross reference. The contents of the
help system gives you access to all areas of the help system.
If you need further explanation on how to use WinBuild, there is an on line tutorial that guides
you through a step by step process on program generation. You may access it by selecting Help
then Tutorial.
The tutorial gives you a step by step process that leads to program generation. TRY IT!!

WinBuild Concepts
The build function is the heart of the WinBuild package. It allows you to easily develop a control
and interface program, test the operator interface functionality of the program, and then generate
the proper BASIC code to run in the OI. You accomplish this feat by generating "Pseudocodes."
You can enter a line of Pseudocode by clicking on the PSEUDOCODE button or clicking the
ACCEPT button. You then must find the appropriate Pseudocode for the task you want to
accomplish. Double clicking on it selects it. You then must follow the instructions for entering
the requested data. You write a program in Pseudocode that represents what you want the
interface and control program to do. Not all of the functionality of the Eason BASIC is
represented in Pseudocodes. At any time in the process of generating the program you find that
you need functionality that the current Pseudocodes don't provide, you can click on the USER
CODE button and enter BASIC directly. Once you have a Pseudocode (and possibly Basic)
representation of what you want your program to do, you click on the COMPILE button that
converts your Pseudocode program into a line numbered BASIC program.

Operating WinBuild-More Power!
The box in the lower left hand corner of your computer screen is a representation of your OI's
screen. While you are generating your Pseudocode program, any line of code that generates
information that will be displayed on the LCD display will show up here. Text, soft key labels,
place holders for variable and operator numeric entry will all show up and can be moved to any
legal location you desire. You will find that as you move the cursor down from Pseudocode line
to Pseudocode line, the screen will build up one line at a time in synchronization with the
Pseudocode line you are on.
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There are a few other important keys and keystrokes to keep in mind. Ctrl-Y or delete will delete
the line where the cursor is currently located. Cut, Copy and Paste are all functions that allow
blocks of Pseudocode to be manipulated. Clicking the PSEUDOCODE button or pressing F5
when the cursor is on a line of Pseudocode will add a new line of Pseudocode above the cursor
location. Clicking the ACCEPT button, double clicking on the Pseudocode or pressing Enter
while on a line of Pseudocode will allow you to edit that line.
The Pseudocode you generate will be organized into Screens. Each screen will have a name
(defined by the SCREEN Pseudocode). The GOTO screen and SOFTKEY Pseudocodes will
allow your program to move from screen to screen. ^F, ^P, ^G, ^N, and ^L (^ means holding the
CTRL key and typing the letter), help you navigate through your Pseudocode program as you are
developing it. If you are on a line of Pseudocode that defines a GOTO or GOSUB to a screen or
a label and press ^G, the cursor will move to the beginning of that screen or to that label. ^N will
send you to the beginning of the next screen definition. ^P will send you to the beginning of the
previous screen definition. ^L will send you to the end of the program. All of these functions are
also available via buttons in the lower right corner of your screen. These function keys become
increasingly helpful as your programs get longer and more involved.
Entering Pseudocode falls into two categories: Entering or placing text on the screen and
everything else. Pseudocodes that have nothing to do with text on screen are relatively simple.
Each bit of information needed to complete a Pseudocode command is asked for one piece at a
time. You can get from entry to entry with the mouse, Tab key or the Enter key. The Enter key
causes you to exit the Pseudocode entry box once everything has been defined. The Tab key
takes you from entry to entry and from the last entry to the first without exiting the screen. Shift
Tab can also be used to go backwards through the fields. You may select the CANCEL button at
any time and abort the Pseudocode entry, or the HELP button to get help on that Pseudocode.
On screen data entry allows you to create complex screens with little effort. Any command that
generates text to be placed on the screen takes advantage of On Screen Editing. The SCREEN
command allows you to place regular text, large text and huge text at any location on the screen.
You first must select the SCREEN Pseudocode as described above. You then must name the
screen (8 characters maximum, numbers only at the end of the screen name). Pressing enter or
clicking on the screen will place you in screen editing mode.
When entering text via the screen command, you are always in overtype mode. You can change
text sizes with the right mouse button or Page Up key. To change between reverse and normal
video press the Page Down key. Once you are done typing the text you want displayed on the
screen, click ACCEPT or press the Enter key. A series of PUT TEXT Pseudocodes will be
placed in your Pseudocode list right below the screen Pseudocode you just entered. These PUT
TEXT Pseudocodes have a one to one relationship with the text you entered on the screen.
To move an existing PUT TEXT Pseudocode, select the desired text in the screen with the
mouse. Click and hold the left mouse button down while moving the text. To edit an existing
PUT TEXT command select the desired text with the mouse and double click on it. You may
now add or change the text that is selected. If you want to move the changed text, click and hold
the left mouse button while moving the text. You can also change the size and color of the text
in the screen command Click the ACCEPT button or press enter to change the Pseudocode.
Certain Pseudocodes (like PUT NUMBER) allow you to specify numeric formats for printing
numbers on the screen. You may specify a digit place holder with a # character. Use the
decimal point (.) character for specifying the location of the decimal point. Use a plus(+) or
minus (-) sign to specify the use of a sign. If you want scientific notation, use an E. For
example:
##.###
+#.#
-#.#

Specifies from 0.000 to 99.999
Specifies from -9.9 to +9.9 (always displays a + or - sign)
Specifies from -9.9 to +9.9 (only displays a - sign if present, otherwise it
displays a blank space)
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###

Specifies from 0 to 999

PUT TEXT has the capability to place text from string variables directly on screen. The actual
process to place the variable may seem a little confusing at first. To place the contents of a
string variable with the PUT TEXT Pseudocode, select the PUT TEXT Pseudocode. Click the
NEXT FIELD box until the "ENTER A STRING OR VARIABLE NAME" data entry field comes up.
Enter the name of the string variable. A "$" will appear on screen. Click on it and hold the left
mouse button while you drag it into position. Click OK to accept.
Selecting Pseudocode is simple.
Clicking the Pseudocode button displays a list of
Pseudocodes that you can choose. The Pseudocode selection window displays the Pseudocode
list, the currently selected Pseudocode, and some helpful information about the currently
selected Pseudocode. If you click ACCEPT, double click the Pseudocode, or press Enter, you
will go to the entry screen (if one is needed) for the selected Pseudocode. You can use the Up
and Down Arrows, scroll bars, as well as the Page Up and Page Down keys, to scroll through the
Pseudocodes. You can also press a letter key to get to the first command in the Pseudocode list
that begins with that letter. For instance, if you are in the list and press S, you will go to the
SCREEN command location in the Pseudocode list.

Using the Editor
WinBuild has a built in editor that is available via the Utility menu, Editor selection. The default
editor is Windows NOTEPAD. You may change this editor by typing in the name of your own
editor in the Utility, Configuration dialog box. Make sure that a DOS path has been set up to
allow WinBuild to find the editor you have selected. If you require additional help on how to use
NOTEPAD, consult your Windows user's guide, or refer to the on line help available for
NOTEPAD.

Using the Terminal
WinBuild has a built in terminal that is available via the Utility menu, Terminal selection. The
default terminal is Windows TERMINAL. You may change this terminal program selection by
typing in the name of your own terminal program in the Utility, Configuration dialog box. Make
sure that a DOS path has been set up to allow WinBuild to find the terminal program you have
selected. If you require additional help on how to use TERMINAL, consult your Windows user's
guide, or refer to the on line help available for TERMINAL.
To change the active COM port for the PC, select the Utility, Configuration dialog box. You
may select the desired COM port by clicking either COM 1 or COM 2.

Sending and Receiving Files
Sending and receiving programs from the OI is simple with WinBuild. To send a program to the
OI, click the SEND button. To read a program from the OI, click the RECEIVE tool. A window
will appear which allows you to select the desired BASIC program to be sent or received
(typically a BAS file). Once selected, a window will appear depicting the status of the transfer. A
line count appears as well as an activity bar. If communications are disrupted, the activity bar
will turn BROWN. WinBuild will retry the line that contained the disruption several times. If it
communications completely fails, the activity bar will turn RED. You will be asked to confirm the
situation by canceling the SEND or RECEIVE operation.
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